
i 

Table of Contents 

Navigating the User Interface ......................................................................................... 1 

Navigating the User Interface: Introduction ................................................................. 1 

The Screen Appearance ............................................................................................. 1 

The Menu Bar ............................................................................................................ 3 

File .......................................................................................................................... 3 

Edit ......................................................................................................................... 4 

View ........................................................................................................................ 4 

Insert ...................................................................................................................... 4 

Operation ................................................................................................................ 5 

Window ................................................................................................................... 5 

Help ........................................................................................................................ 5 

Selecting Options from the Menu Bar with the Keyboard ........................................ 6 

The Toolbar Area ....................................................................................................... 7 

The Graphic Display Window ..................................................................................... 7 

The Status Bar ........................................................................................................... 7 

Dialog Box Description ............................................................................................... 8 

Edit Box ................................................................................................................ 10 

List Box ................................................................................................................. 11 

Option Buttons ...................................................................................................... 13 

Check Boxes......................................................................................................... 14 

Dialog Box Tabs ................................................................................................... 15 

Drop Down List Box .............................................................................................. 16 



Table of Contents 

ii 

Accessing Dialog Boxes Options .......................................................................... 16 

Scrolling the Edit Window ..................................................................................... 16 

Moving Dialog Boxes ............................................................................................ 16 

Customizing the User Interface ................................................................................ 17 

Restoring the Default User Interface ..................................................................... 18 

Customizing User Interface Fonts ......................................................................... 19 

Customizing Menus .............................................................................................. 20 

Customizing Toolbars ........................................................................................... 25 

Customizing Shortcut Keys ................................................................................... 28 

Docking and Undocking User Interface Elements ..................................................... 30 



1 

Navigating the User 
Interface 

Navigating the User Interface: 
Introduction 

This section provides an introduction to using PC-DMIS. It documents the fundamental 
actions needed to operate the software. To fully exercise the capabilities of PC-DMIS 
and make your measurement routine programming as easy as possible, please read 
through this entire section and follow along on your computer. 

This section also highlights ways to customize some of PC-DMIS's graphical options to 
best meet individual needs. (Additional information on these available options can be 
found in the "Editing the CAD Display: Introduction" section.) 

Each topic listed below illustrates a specific feature of the interface. The following are 
covered in this section: 

• The Screen Appearance 

• The Menu Bar 

• The Toolbar Area 

• The Graphic Display Window 

• The Status Bar 

• Dialog Box Description 

• Customizing the User Interface 

PC-DMIS provides the flexibility of using the mouse or keyboard to enter commands or 
select options. Shortcut menus and shortcut keys have been assigned to frequently 
used commands. See the "Using Shortcut Keys and Shortcut Menus: Introduction" 
section. 

The Screen Appearance 

The PC-DMIS user interface is divided into several distinct areas, each of which fulfills a 
specific function or supplies needed information. A brief description of each screen area 
is listed below. (Additional information is located throughout the documentation as 
indicated.) 
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Screen appearance of the PC-DMIS user interface 

1. The title bar does the following: 

• Displays version information 

• Displays the currently loaded measurement routine 

• Displays if PC-DMIS is in Administrator mode 

 

2. The menu bar contains the menus and menu items available from the PC-DMIS 

application. For information, see "The Menu Bar". 
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3. The toolbar area contains toolbars with frequently used commands. These 

toolbars are easily accessible by right-clicking on the toolbar area. See "The 

Toolbar Area". 

4. The Graphic Display window presents graphic representations of the part (the top 

view is shown in the illustration). The size of this area remains constant. 

However, the display area can be divided into as many as four different views of 

the part. For information, see "The Graphic Display Window". 

5. Dialog boxes are the main communication channels between Planner and the 

user. Available features appear in the dialog box, and most input data is entered 

through it. For information, see "Dialog Box Description". 

6. The Edit window displays the measurement routine. This window allows you to 

access specific commands within the measurement routine and make changes to 

meet individual specifications. See the "Editing a Measurement Routine: 

Introduction" and "Using the Edit Window: Introduction" chapters for fully 

documented operations of the Edit window. 

7. The status bar displays information important to the current operation. This 

includes information such as the probe's current position, the probe calibration 

data, standard deviation of the last feature measured, the number of hits, and 

other information. It also contains a message area to display prompts and 

pertinent information about the operation in progress. For more information, see 

"The Status Bar". 

The Menu Bar 

 

The topics below give a brief description of each menu. For additional information, see 
the appropriate chapter as needed. PC-DMIS also provides a variety of shortcut menus. 
These menus are discussed in the "Using Shortcut Keys and Shortcut Menus: 
Introduction" chapter. 

To get help on specific menu items, position your mouse pointer over the menu item, 
and press F1. 

File 

The File menu lets you open, save, and print files, access the Edit window, run 
measurement routines with the Execute Mode, and exit out of current measurement 
routines. See the "Using Basic File Options: Introduction" and "Using Advanced File 
Options: Introduction" chapters for more information. 
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Edit 

The Edit menu allows you to edit your measurement routine preferences, your 
measurement routine, or the CAD display. 

• To edit your preferences, see the "Setting Your Preferences: Introduction" 

chapter for complete information. 

• To edit your measurement routine via the Edit window, see the "Editing a 

Measurement Routine: Introduction" and "Using the Edit Window: Introduction" 

chapters for complete information. 

• To edit the display of the CAD drawing, see the "Editing the CAD Display: 

Introduction" chapter for complete information. 

View 

The view menu allows you to access all the windows, editors, and toolbars available to 
PC-DMIS. See the "Using Other Windows, Editors, and Tools: Overview" chapter for 
complete information. 

Insert 

The bulk of a measurement routine's commands can be accessed from the Insert 
menu. 

Most of the chapters comprising this documentation come from the options and 
submenus displayed on this menu. 

• Options on the Hardware Definition submenu are discussed in the "Defining 

Hardware" chapter. 

• Options on the Feature submenu are discussed in these chapters: "Creating 

Auto Features", "Creating Measured Features", "Constructing New Features from 

Existing Features", "Creating Generic Features". 

• Options on the Alignment submenu are discussed in the "Creating and Using 

Alignments" chapter. 

• Options on the Dimension submenu are discussed in the "Using Legacy 

Dimensions" chapter. 

• Options on the Scan submenu are discussed in the "Scanning your 

Part" chapter. 

• Options on the Move submenu are discussed in the "Inserting Move 

Commands" chapter. 
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• Options on the Flow Control Command submenu are discussed in the 

"Branching by Using Flow Control" chapter. 

• Options on the Statistics Command submenu are discussed in the "Tracking 

Statistical Data" chapter. 

• Options on the Report Command submenu, including the ability to add Diminfo 

and Pointinfo boxes onto your CAD display and into your measurement routine, 

are discussed in the "Inserting Report Commands" chapter. 

• Options on the File I/O Command submenu are discussed in the "Using File 

Input / Output" chapter. 

• Options on the Modules submenu represent the toolkit modules installed with 

PC-DMIS. 

• The remaining options on the Insert menu are discussed in the "Using 

Expressions and Variables " chapter and the "Adding External 

Elements" chapter. 

Operation 

The items on the Operation menu are discussed in various topics of the 
documentation. 

Window 

The Window menu allows you to manage the display of all open measurement 
routines. See the "Navigating and Displaying Multiple Windows" chapter. 

Help 

The Help menu provides these menu items: 

Index - This item opens the PC-DMIS help file. The help file provides comprehensive 
information about PC-DMIS commands, dialog boxes, menu items, messages, and so 
on. To activate the PC-DMIS help file, select this item from the Help menu, or press F1 
at any time. The first time you run the Help after installation, it may take several 
seconds. Thereafter it opens more quickly.  

Using Help - This item opens the PC-DMIS help file to the "Using the Online Help" 
chapter. The topics there provide hints and tips about searching for and locating 
information in the help. 

Release Notes - This item shows the readme.pdf that ships with this version of the 
software. The readme.pdf contains information about this version of PC-DMIS. 
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What's New - This item opens shows featured enhancements for this version of PC-
DMIS in your browser. 

Idea Center - This item takes you to the PC-DMIS page of the HexagonMI Idea Center 
website. On that site, you can share your ideas and vote on other users' ideas to help 
direct the development of PC-DMIS. 

PC-DMIS User Forum - This item opens the PC-DMIS User Forum in your browser. 
From this forum, you join peer-to-peer discussions about many different PC-DMIS 
topics. 

Check for Updates and Automatic Check at Startup - These items use the UPDATE 
CENTER application to keep your software up-to-date. For more information see 
"Updating the Software" in the "Getting Started: An Overview" chapter. 

About - This item opens the About dialog box. This dialog box gives you specific 
version and license information. It also provides a unique Machine ID for your 
computer, which may be used in some status and notification messages. 

Selecting Options from the Menu Bar with the 
Keyboard 

To open a menu and browse through the options using the keyboard, press the ALT key 
followed by the underlined letter in the name of the menu to be opened. 

 To open the View menu using the keyboard, press ALT and V (the underlined 
letter). Options can be selected from the menu in a similar manner. Simply press the 
underlined letter to the corresponding option (i.e., Cut:  press the T key). 

Menus also can be opened using the arrow keys. 

To do this: 

1. Press the ALT key to switch to the menu bar. 

2. Use the LEFT/RIGHT ARROW keys to move to the desired menu. 

3. Use the UP/DOWN ARROW keys to select an option. 

4. When the desired option is highlighted, press the ENTER key. 

Shortcut keys also have been assigned to many of the options. The shortcut key is 
shown to the right of the command or option. 

See the "Using Shortcut Keys and Menus" chapter for more information. 

https://www.pcdmisforum.com/forum
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The Toolbar Area 

PC-DMIS provides you with a variety of toolbars composed of frequently used 
commands. These toolbars can be accessed in one of these two ways. 

1.  Select the View | Toolbars submenu and select a toolbar from the menu 

provided. 

2. Right-click on PC-DMIS's Toolbar area and select a toolbar from the shortcut 

menu provided. 

Once you have a toolbar in the toolbar area, you can move the toolbar by first clicking 
on the space between the left or right edge and a button and then dragging the toolbar 
to a different location. 

For in-depth information on all of PC-DMIS's toolbars, see the "Using Toolbars" chapter. 

The Graphic Display Window 

The Graphic Display window, quite simply, displays graphics. This window is opened by 
default when you create or access a measurement routine. To hide or view this window, 
select the View | Graphic Display Window menu option. This window displays the 
following: 

• A multi-paned graphical representation of an imported CAD part, the probe, and 

any simulated machines or fixtures. 

• The measured, auto, and constructed features and their ID labels. 

• The scans, dimensions, GD&T callouts, and text box displays. 

The Graphic Display window is an integral part of PC-DMIS. For information on editing 
the Graphic Display window and altering the screen display, see "Editing the CAD 
Display" chapter.  

The Status Bar 

 

The status bar displays the following: 



Navigating the User Interface 

8 

A. Message Box: The left-most box displays instructions and other information 

regarding the current procedure or command. 

B. X, Y, and Z boxes: These boxes show the X, Y, and Z position of the probe. 

Clicking on any of the three coordinate displays within the status bar will cause 

the Auto Move Point dialog box to appear. (See "Inserting a Move Point 

Command" in the "Inserting Move Commands" chapter for additional information 

regarding DCC Move Point.) 

C. W: Angle of Rotary Table. 

D. A, B, and C boxes: These boxes show the A, B, and C wrist angles for a three-

axis wrist probe such as a CMS probe. Your wrist probe may only support two 

axes. In that case, this portion of the status bar only shows A and B. 

E. SD: This shows the standard deviation of the last feature measured. 

F. # of Hits: This shows the number of hits currently taken. 

G. IN/MM: This shows the current unit of measurement used for the measurement 

routine. 

H. Line: This box displays a number that indicates the current line where the cursor 

is located in the Edit report. Col: This text displays a number that indicates the 

current column where the cursor is located in the Edit report. 

Status Bar Manipulations 

• To increase the size of the status bar, select View | Status Bar | Large. Due to 

its increased size, this large status bar only displays the Message, the XYZ , the 

SD, the # of Hits:, the Line:, and the Col: boxes. 

• To put the status bar back to its normal size, select View | Status Bar | Normal. 

• To hide or show the status bar, select View | Status Bar | Hide Status Bar(s). 

Dialog Box Description 

A dialog box provides various boxes and buttons (called controls) that can be selected 
to tell PC-DMIS how to carry out a command. Sometimes a dialog box shows default 
settings already selected, which if satisfactory can be left as they are. After you modify a 
dialog box, click OK to carry out the command. To cancel the command and close the 
dialog box, click the Cancel button. 

The graphics illustrate some features common to most dialog boxes in PC-DMIS. 
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A - Edit Boxes or Fields 

B - List Box 
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C - Drop Down List Box 

D - Check Boxes 

E - Command Buttons 

F - Tabs   

Edit Box 

An edit box allows you to type in a desired value or name. In this documentation, edit 
boxes are simply referred to as "boxes". Edit boxes common to many of PC-DMIS's 
dialog boxes are listed here: 

ID= [Feature] 

 

This box shows the Feature or Dimension identification or name for the features or 
dimensions to be created. 

To change the ID: 

1. Select the previous ID. 

2. Type a new ID. 

3. Press the TAB key. 

For a Dimension ID: 

• You can change only the number portion of the ID and reset the dimension 

counter to a desired count. 

• You can change the text portion of the ID and set it as the default text for 

subsequent dimensions. (See the ID Setup tab of the Setup Options dialog box 

in the "Setting Your Preferences" chapter.) 

Search ID 

 

In the Search ID box you can type the feature (or dimension) IDs to use in the current 
operation. You can use this box to search using meta-character search options. The 
feature or dimension IDs will be highlighted in the appropriate Feature List box (or 
Dimension List box). 
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If you type a feature's ID in the Search ID box and press ENTER, PC-DMIS selects that 
feature from the Feature List or Dimension List box. 

Select Last # 

 

In the Select Last # box, you can select the last of a certain number of features (or 
dimensions). For example, if you wanted to select the last four features that were 
created, simply type 4 and press the TAB key. PC-DMIS will highlight the features 
selected in the Feature List box. 

List Box 

A list box is similar to an edit box; however, changes cannot be made to the listed 
values. This documentation refers to either "list" or "box" for the list box. Lists common 
to many of PC-DMIS's dialog boxes are listed here: 

Feature List box 

 

Feature List box 

A feature list box contains a list of the available features within a measurement routine. 
PC-DMIS uses the selected features to define alignments, construct new features, 
create dimensions, and perform other tasks. You can select features by following the 
instructions in the "Selecting Features Using the Graphic Display Window" topic in the 
"Editing the CAD display" chapter. 
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 You can also use the Graphical Hit Selection method to select inputs to your 
alignment, construction, or dimension. For details, see "Graphical Hit Selection 
Method". 

You can add new features while the dialog box is open if you use the QuickFeature 
functionality. PC-DMIS selects the features in the list as you create them. For more 
information on creating QuickFeatures, see "Creating QuickFeatures" in the "Creating 
Auto Features" chapter. 

A feature displayed in red text with an asterisk (*) to the left of it represents a feature 
that has been skipped during measurement routine execution. 

You can deselect selected (highlighted) features with the Clear or Clear List buttons. 

If you are attaching an external measurement routine (see "Attaching an External 
Measurement Routine" in the "Adding External Elements" chapter), PC-DMIS also lists 
the variable (or pointer) used to reference the attached measurement routine. A plus 
sign (+) appears to the left of the pointer. Clicking this plus sign expands or collapses a 
view of all the features in the attached measurement routine. 

Sorting the Features 

Clicking the drop-down arrow button located at the top of the Feature List box displays 
the various sorting methods available as shown below. 

 

Feature List Sort menu 

Once a selection is made, the list is automatically sorted based on the selected option. 
As new items are added to the list, clicking on the Sort button will re-sort the list based 
on the currently sorted options shown on the button. Re-clicking the button will sort the 
list in reverse as shown be the up or down arrow to the right of the displayed sorting 
method. 

Sorting Options Defined 

• ID - Sorts the list alphabetically based on feature ID. 

• Type - Sorts by feature type. In this case, the feature's ID is used as a secondary 

sort criteria. 
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• Routine - Sorts the list based on the order the feature appears in the 

measurement routine. 

• Time - Sorts the list based on the times the features were last measured. 

Dimension List box 

 

The Dimension List box contains a list of all the dimensions that were created within a 
measurement routine. You can edit or analyze a dimension by selecting the desired 
dimension in the list box and selecting the desired changes or options in the associated 
dialog box. You select multiple dimensions at a time by holding down Ctrl or Shift and 
clicking on another dimension. 

Inside the Edit Dimension Info dialog box, if the dimension already has a Dimension 
Info box associated with it, PC-DMIS shows an asterisk (*) symbol next to the 
dimension ID in the list. If the dimension info is hidden in all current views, it adds a 
number sign (#) symbol next to the ID. 

For example, suppose you have a roundness dimension named RND1 for a circle 
named CIR4. If the roundness dimension already had a DIMINFO box associated with 
it, yet that DIMINFO box was hidden from all views in the Graphic Display window, the 
ID in the list would look like this: 

 

Example of asterisk and number sign symbols  

Option Buttons 

The area containing option buttons displays available choices for the dialog box. You 
can switch between available choices by clicking on the desired button. When an option 
is chosen, a black dot appears to the left of the selected option and all other options are 
cleared. You can only select one option button in that area. 
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Check Boxes 

Click on check boxes to turn options on or off. The option is considered "on" when a 
check mark appears inside the box. You can select multiple check boxes. 

A command button carries out an action. The command buttons that are common to 
most dialog boxes in PC-DMIS are listed here: 

Apply - This button applies your selections to the dialog box but keeps the dialog 
box open for further changes. 

OK - This button saves, applies the changes, and closes the dialog box. On some 
dialog boxes, this button inserts commands into the Edit window. 

Cancel - This button ignores any changes and closes the dialog box. 

Delete - This button removes items (such as created features, dimensions, probe 
files, alignment information, and so on) from certain list boxes. In the Delete CAD 
dialog box, the Delete command button deletes selected nominal features. For 
more information, see "Deleting CAD". 

Last - This button selects the last item in the associated list box. 

Last Two - This button selects the last two items in the associated list box. 

Select All - This button selects all the items in the associated list box. 

Default - This button updates the default settings of several parameters. When 
you create a new measurement routine, it reflects any changes that are stored as 
the default values. 

The default values are stored in the system registry. You can update these 
parameters through the appropriate dialog box or use the PC-DMIS Settings 
Editor to edit the registry itself. This application is included with your PC-DMIS 
install set. For more information, see "Modifying Registry Entries". 

• If you click the OK button without clicking the Default button, the defined 

parameters applies only to the active measurement routine and will not 

affect the registry entries. 

• If you change a parameter and then click the Default button, PC-DMIS 

updates the registry entries to redefine the default to the current entry. 

The Default button allows you to store and apply new default values to new 
measurement routines created later on. 
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Recall - This button calls back the original factory settings as long as the original 
values haven't changed through clicking the Default button. In that case, PC-
DMIS returns the stored values in the registry. 

For information on how to use the Machine Options dialog box to restore original 
factory settings by reading them from the controller, see "Setting Up the Machine 
Interface" in the "Setting Your Preferences" chapter. 

Create - This button applies changes made in certain dialog boxes and creates 
features, dimensions, scans, and so on. It then places the created item into the 
Edit window and the Graphic Display window. 

The Create button won't close the dialog box. To close the dialog box, click the 
Close button. 

Close - This button closes the dialog box. The OK, Apply, or the Create button 
doesn't automatically close the dialog box with some dialog boxes (where you may 
want to select further options). 

Clear - This command button clears the highlight of any selected item from the list 
boxes. In some cases, this button completely removes items from certain list 
boxes (such as the AB positions from the New Angles List box). 

In some dialog boxes and tabs, the Clear button clears any values that were 
entered or changed before either the Apply or the OK button was clicked, and 
restores the "built in" values in PC-DMIS. If you have used the Default button to 
store default values, then PC-DMIS restores those values. 

Undo - This button reverses changes that you made using the Apply button (or 
the Generate button in DCC scans). Once you click the OK button, you cannot 
reverse the changes. 

Help - This button opens the online Help topic associated with the current dialog 
box. 

Dialog Box Tabs 

Some dialog boxes contain tabs. These tabs act as identifying markers much like a 
folder's name in a filing cabinet would. Click on a tab to bring a desired window or 
options in front of the other tabs. Any options or commands associated with that tab are 
then displayed. 
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Drop Down List Box 

A drop-down list box works like menus. Click on the drop-down arrow icon  to the right 
of the current choice, or press ALT and the UP ARROW or DOWN ARROW key on the 
keyboard consecutively. Pressing F4 will also display the available options. Press the 
key(s) again to close the list. The current choice is shown in the highlighted box. 

Accessing Dialog Boxes Options 

The mouse or keyboard can be used to access options within the dialog box. To access 
an option using the mouse, simply point to the desired option and click. 

The keyboard offers a variety of ways to move between available options: 

• Press the Tab key to move to the next available option. 

• Press Shift + Tab to move to the previous available option. 

• Press the Arrow key to display a current drop-down list. 

• Press the Enter key to select the current command. 

• Press the Space Bar to select the current check box or button.  

Scrolling the Edit Window 

The Edit window can be moved in the same manner as a dialog box. See "Moving Dialog 
Boxes" 

The Edit window has scroll bars for viewing additional data in the window. 

To scroll: 

1. Place the mouse pointer on one of the scroll arrows. 

2. Click or hold the left mouse button. 

PC-DMIS scrolls the text in the scroll arrow's pointed direction. For example, to scroll 
down, select the down scroll arrow with the pointer and click the left mouse button. 

See the chapters "Editing a Measurement Routine" and "Using the Edit Window" for 
complete information regarding the Edit window. 

Moving Dialog Boxes 

You can use the mouse to move a dialog box or window. 

To move a dialog box or window: 
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1. Place the mouse pointer over the title bar. 

2. Hold down the left mouse button. 

3. Drag the dialog box or window to the desired position in the Graphic Display 

window. 

4. Release the mouse button. 

PC-DMIS moves the dialog box or window to its new location. 

PC-DMIS stores the last position of the various PC-DMIS dialog boxes. When you re-
open the dialog box, it opens the dialog box at the last used location, even across 
multiple monitors. 

 If you move PC-DMIS to another monitor, PC-DMIS resets the dialog box 
positions. This means it opens the dialog boxes in their default position on that monitor.  

You can dock some dialog boxes and other interface elements inside the rest of the 
user interface. You may need to undock these items before you move them. For details 
on how to dock and undock UI elements, see "Docking and Undocking User Interface 
Elements". 

Customizing the User Interface 

You can reorganize menus, add your own programs to menus, or create new menus 
and options altogether. PC-DMIS also allows you to link commands native to PC-DMIS 
and customized commands to toolbars. Instructions on how to modify the user interface 
are in the following topics: 

• Restoring the Default User Interface 

• Customizing User Interface Fonts 

• Customizing Menus 

• Customizing Toolbars 

• Customizing Shortcut Keys 
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 The organization of this documentation is based on the default user interface 
shipped with this version PC-DMIS. Be aware that customizing the user interface may 
make existing documentation difficult to follow. 

Restoring the Default User Interface 

If you want to restore PC-DMIS's appearance to the default user interface shipped with 
this version of PC-DMIS, follow this procedure: 

1. Close PC-DMIS. 

2. Navigate to the directory where you installed PC-DMIS. 

3. Access the directory that corresponds to your Windows user profile. 

4. Delete the file named menu_xxx.dat where xxx refers to the three letter code for 

the language you're running. For English, delete menu_eng.dat. 

5. Restart PC-DMIS. It will use the default user interface. 
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Customizing User Interface Fonts 

 

Change all the fonts dialog box 

To modify font attributes, access the Font Setup dialog box by selecting the Edit | 
Preferences | Fonts menu option. Use this dialog box to change font attributes, 
including font, size, and style for the main user interface; for the Graphic Display 
window; and for the Edit window. 

To change the font: 

1. Click one of these buttons to open a standard Font dialog box: 

• Application Font - This changes the font of the main application. This 

includes the lists on the Settings toolbar, the Preview window, the 

Readout window, the status bar, message boxes, and so on. 

• Graphic Font - This changes the font for text in the Graphic Display 

window. This affects feature labels, Dimension Info and Point Info text 

boxes, and so on. The Color list on the Font dialog box that appears sets 

the background color for CAD GD&T characteristic IDs. For information on 

these characteristic IDs, see "Working with CAD GD&T Callouts" in the 

"Editing the CAD Display" chapter. 
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• Edit Window Font - This changes the font for the Edit window. For a 

recommended font for the Edit window, see the note below. 

3. From the Font dialog box, use the lists and select your font changes. 

4. Click OK to close the Font dialog box. 

5. From the Font Setup dialog box, click OK to accept your change. 

 You can use any font available on your computer system; however, some fonts 
don't have a uniform spacing. This can make some components more difficult to read. 
For the Edit window text, we recommend that you use a monospace, fixed-width font, 
such as the Courier New font. Otherwise, characters, lines, and headings may not line 
up as expected. 

CAD GD&T Font size 

This slider scales the size of any GD&T CAD elements that appear in the Graphic 
Display window. Each increment above or below the midpoint increases or decreases 
the font by 10%. The font size changes dynamically as you adjust the slider. Click OK to 
keep the changed font size. 

Customizing Menus 

To customize the menus on the menu bar: 

1. Access the Customize dialog box by selecting the View | Toolbars | Customize 

menu option. 

2. Select the Menu tab. 
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Customize dialog box – Menu tab 

You can use this tab to add new menu items, move existing menu items, or remove 
menu items from the menu bar altogether. 

You can use the Use large menus check box to show all menu items in a larger font. 
PC-DMIS will need to restart to apply the large menu sizes. 

To Move a Menu Item 

To move a menu item to a new location on the menu bar: 

1. Access the Customize dialog box by selecting the View | Toolbars | Customize 

menu option, and click the Menu tab. 

2. Navigate to the menu item you want to move on PC-DMIS's actual menu bar (not 

the tree view menu list in the Menu tab). 

3. Select the desired menu item. 

4. Drag it to the new position. As you drag the item through the menu structure, a 

small red arrow  appears, indicating where you want to add the item. 

5. Release the mouse button. The menu item is moved from its original location to 

the new location. 

6. Click OK to accept your changes and close the Customize dialog box. 
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To Remove/Restore a Menu Item 

To Remove a Menu Item from the Menu Bar: 

1. Access the Customize dialog box by selecting the View | Toolbars | Customize 

menu option, and click the Menu tab. 

2. Navigate to the menu item you want to remove on PC-DMIS's actual menu bar 

(not the tree view menu list in the Menu tab). 

3. Select the desired menu item. 

4. Drag it off of the menu bar area. 

5. Release the mouse button, and the menu item is removed from the menu. 

6. Click OK to accept your changes and close the Customize dialog box. 

To Restore a Removed Menu Item: 

1. Access the Customize dialog box by selecting the View | Toolbars | Customize 

menu option, and click the Menu tab. 

2. Navigate in the Menu tree view list to the menu item you want to restore. 

3. Select the menu item and drag it up onto PC-DMIS's actual menu bar. As you 

drag the item through the menu structure, a small red arrow  will appear 

indicating where the item will be added when you release the mouse button. 

4. Release the mouse button to insert the menu item. 

To Edit an Existing Menu Item 

You can edit existing menu items, including menu item names, descriptions, and 
ToolTips. To do this: 

1. Access the Customize dialog box by selecting the View | Toolbars | Customize 

menu option. 

2. With the dialog box open, click on PC-DMIS's menu bar. 

3. Select a menu and then right-click on the menu item you want to change on PC-

DMIS's actual menu bar (not the tree view menu list in the Menu tab). The Edit 

Menu Item dialog box appears. 
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Edit Menu Item dialog box 

4. Modify the menu item using this dialog box and then click OK. 

5. Click OK on the Customize dialog box. 

6. Verify your change. 

 In the Menu Text box, the letter that follows the ampersand sign (&) indicates 
that the letter is used with the Alt key to quickly select that menu item (for example 
selecting Alt + F + N accesses the New menu item from the File menu). 

To Add a New Menu Item 

You can create your own custom menu item and tie an external program or batch file to 
it. To do this: 

1. Access the Customize dialog box by selecting the View | Toolbars | Customize 

menu option, and select the Menu tab. 

2. Click the Create Item button. The Custom Wizard / Script / Tool dialog box 

appears. 

3. Click the ‘…’ button. An Open dialog box appears. 

4. From the Files of Type list, select the type of file you to insert. 

5. Navigate to the directory containing the custom application, batch file, BASIC 

script, and so forth. 

6. Select the file to insert, and click Open. The Open dialog box closes and the 

Custom Wizard / Script / Tool dialog box displays the default information 

associated with the custom program you selected. 
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Custom Wizard / Script / Tool dialog box showing a sample application 

Command File: 
This box shows the pathway to the command. 

Menu Text: 
This box allows you to specify the name used on the menu for this item. 

Help Desc: 
This box allows you to define information that PC-DMIS displays in the status bar 
when you move your mouse over the item. 

Tool Tip: 
This box allows you to specify the tooltip text displayed for this item when you 
hover your mouse over it. This only works if the custom item is added to a 
toolbar, not a menu. 

Function: 
This box remains unavailable for selection unless you are using a custom BASIC 
script. Once the box becomes enabled, you can use it to define the function or 
subroutine that runs from the loaded .bas file. Type the routine name without 
parenthesis. For example, typing "TestFunction" launches the TestFunction 
routine when the BASIC script is executed. 

Change Icon: 
This button allows you to change the icons displayed for this menu item. 

7. Make any additional changes to this dialog box. 

8. Click OK to accept your changes. PC-DMIS inserts the newly created command 

into the User Defined Commands tree view list in the Menu tab of the 

Customize dialog box. 

9. Expand User Defined Commands tree view list. 

10. Select the newly created command and drag it up onto PC-DMIS's actual menu 

bar. As you drag the item through the menu structure, a small red arrow  will 

appear indicating where the item will be added when you release the mouse 

button. 

11. Release the mouse button to insert the command. 

12. Close the Customize dialog box. The newly inserted menu item now resides in 

your menu bar. 
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Customizing Toolbars 

To customize the toolbars that appear on the toolbar menu: 

1. Access the Customize dialog box by selecting the View | Toolbars | Customize 

menu option. 

2. Select the Toolbars tab. 

 
Customize dialog box – Toolbar tab 

You can use this tab to add new toolbars and new toolbar icons, add new pulldown 
toolbars, remove custom toolbars, remove toolbar icons, and reorder toolbar icons on 
existing toolbars. 

You can use the Use large toolbars check box to show all toolbar icons in a larger 
size. This change happens automatically when you click OK or Apply. PC-DMIS does 
not need to restart. 
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To Modify an Existing Toolbar 

You can modify existing toolbars in a number of ways as described below. First, access 
the Customize dialog box by selecting the View | Toolbars | Customize menu option, 
and click the Toolbars tab. 

To add a menu item to a toolbar: 

1. Select the toolbar from the Toolbar definition list. 

2. Find the item you want to add in the Available items list. 

3. Select it, and click the Add→ button. The item appears on the desired toolbar. 

4. Click Apply and then OK to accept your changes. 

To remove a toolbar icon: 

1. Select the toolbar from the Toolbar definition list. 

2. Find the item in the list to remove (right side of dialog). 

3. Select it and click the Remove button. 

4. Click Apply and then OK to accept your changes. 

 Existing toolbars must have at least one icon on them. If you remove the 
last icon and click Apply or OK, the icon still remains on the toolbar. 

To erase any changes: 

Click the Reset button. As long as the OK or Apply buttons haven't been clicked, the 
toolbar reverts to its previous state. 

To remove all customized toolbars and restore the layout shipped with this 
version: 

Click the Default button. 

To create a new toolbar item: 

Click New. The Custom Wizard / Script / Tool dialog box appears. Select item to add. 

This documentation covers the process of adding custom items in the "To Add a New 
Menu Item" topic above. 
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To rearrange the item order on a toolbar: 

1. Select the toolbar from the Toolbar definition list. 

2. Select the item you wish to move. 

3. Click the up arrow   or down arrow  button to move the item up or down 

respectively among the other toolbar icons in the list. 

To rename a toolbar: 

1. Select the toolbar from the Toolbar definition list. 

2. Click Rename. A New Toolbar Name box appears. 

3. Type a name in the box and click OK. 

PC-DMIS also allows another way to rearrange or delete items from any custom toolbar 
on the fly. This is by using the Shift key. Consider the following: 

To delete or rearrange a toolbar's icons: 

1. Press and hold the Shift key. 

2. Click and drag an icon. The icon becomes movable. 

3. If rearranging the icon, drag it to a new spot on the toolbar. 

4. If deleting the icon, drag it outside of the toolbar's boundaries. 

5. Release the mouse button. The change is made. 

 Since existing toolbars must have at least one icon on them, if you remove the 
last icon in this fashion, it only remains removed until you restart PC-DMIS. After 
restarting, the icon reappears. 

To add a separator: 

1. Press and hold the Shift key. 

2. Click and drag an icon. The icon becomes movable. 

3. Drag it a small distance to the right (not far enough to rearrange its position). 

4. Release the mouse button. The separator appears at its left. 

To delete a separator: 

1. Press and hold the Shift key. 

2. Click and drag the icon to the right of the separator. The icon becomes movable. 

3. Drag it on top of the separator to its left. 
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4. Release the mouse button. 

To Create a Custom Toolbar 

1. Access the Customize dialog box by selecting the View | Toolbars | Customize 

menu option, and select the Toolbars tab. 

2. Click New and select Toolbar. An input box appears requesting a toolbar name. 

3. Type the name of the toolbar and click OK. Your new toolbar now appears in the 

Toolbar Definition list. You can now modify the toolbar to accept new toolbar 

icons (see "To Modify an Existing Toolbar"). 

To Delete a Custom Toolbar 

1. Access the Customize dialog box by selecting the View | Toolbars | Customize 

menu option, and select the Toolbars tab. 

2. Select the toolbar from the Toolbar Definition list. 

3. Click the Delete button. 

4. Click Apply to apply your changes. 

Customizing Shortcut Keys 

To customize the shortcut keys used for menu items and commands in PC-DMIS: 

1. Access the Customize dialog box by selecting the View | Toolbars | Customize 

menu option. 

2. Select the Keyboard tab. 
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Customize dialog box – Keyboard tab 

You can use this tab to modify the shortcut keys used to call commands within PC-
DMIS and add new shortcut keys for custom menu and toolbar items. 

To Add Shortcut Keys to a Command 

1. Access the Customize dialog box by selecting the View | Toolbars | Customize 

menu option, and select the Keyboard tab. 

2. Select the command you want to modify by using the Category and Menu 

Selection lists. Once you have selected a command in the Commands list, the 

current shortcut key(s), if any are assigned to that command, will be displayed in 

the Current Shortcuts box. 

3. Highlight the command for which you will assign new shortcut keys. 

4. Click in the New Shortcut box. 

5. Type the keys you want to assign to this command. The keys you pressed 

appear as you type them. 

6. Click the Assign button, and the new shortcut keys appear in the Current 

Shortcuts box with any other shortcut keys currently assigned to the command. 

7. Click Apply to accept your changes. 
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 As in the other tabs, you can use the Create button to first create a command 
and tie it to a custom program. You can then select this command by clicking on User 
Defined from the Menu Selection list. All user-defined commands appear in the 
Commands list. 

To Remove Shortcut Keys from a Command 

1. Access the Customize dialog box by selecting the View | Toolbars | Customize 

menu option, and click the Keyboard tab. 

2. Select the command you wish to modify by using the Category and Menu 

Selection lists. Once you have selected a command in the Commands list, the 

current shortcut key or keys, if any are assigned to that command, are displayed 

in Current Shortcuts box. 

3. Select the command from which you want to remove the shortcut keys. 

4. Select the shortcut key to remove. 

5. Click the Remove button. 

6. Click Apply to accept your changes. 

Docking and Undocking User Interface 
Elements 

Some user interface elements (such as toolbars and some dialog boxes) can dock 
themselves into the Edit window or the toolbar area when you drag and drop the item on 
top of one of those areas. If you don't want this, hold down the Ctrl key while you 
release the mouse button. The toolbar or dialog box then hovers over the dockable 
background instead. 

Some items, such as the Edit window, contain a right-click menu item (Docking View) 
that allows you to dock or undock that item. If the right-click menu item is not selectable, 
close any open dialog boxes and try again. 

You may need to cascade (Window | Cascade) or tile (Window | Tile Horizontally or 
Window | Tile Vertically) your windows and then click and drag a window's title bar to 
float one over another. 
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